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� Comprehensive data management tool 
– An integrated environment for managing databases and developing 

database applications

� Manage database objects based on change plan: Create, Alter, 
Drop

� Database Commands/Utilities Task Assistant

� Data Management

� Develop and execute SQL scripts

� Impact analysis

� Compare database objects

� Develop, debug, and deploy database applications and database 
routines

What is IBM Data Studio?
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� Replaces Control Center from DB2 10

� Built on the popular Eclipse framework

� Support for Red Hat Linux, SUSE Linux, Windows

� Optional extra component

– Data Studio Web console: health and availability monitoring

� No Charge to download and use!

� Support through PMRs and DeveloperWorks forum

What is IBM Data Studio? (cont)
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Switching between Admin and Development



5

IBM Information Management

© 2013 IBM Corporation5

Flatter View

Hierarchy View

Flatter view and Hierarchy view
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� Flatter view: Click on a type of objects in Administration Explorer to list 
the objects in Object List on the right side.
– Object List contains several features to facilitate navigation such as: 

in-place searching, sorting, etc.

� Hierarchy View: Navigation in Data Source Explorer  will see an object 
hierarchy, Schema->Table->Index

� User can also use the breadcrumb navigated like web browser

� Show related objects: User can also right click an object , Show-> Show 
Indexes etc to navigated to relative objects

� Object Filter: Two way filter
– Database Catalog filter is  filter the object load from data server

– Name search in object list is only for search on UI

© 2013 IBM Corporation6

Multiple navigation
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� Filter load objects

� Filter in current loaded objects

Object Filter
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� Multi-purpose navigation bar

– Web-browser-like back / forward navigation

– Breadcrumb navigation facilitates moving through hierarchy of objects

– Create new object button

– In-place search function. Type object name or part of it and list is dynamically updated.

– Support use of wildcards

– Options to sort, filter, refresh objects list

© 2013 IBM Corporation8

Back/Forward Current Path

New Object

Search Options

Switch to other object

Navigation in breadcrumb
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Navigate by related objects
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I Just want to run a SQL
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1. Launch SQL
Editor

2. Type SQL

3. Run SQL

4. Inspect Results

Launching the SQL Editor
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So I want to run a script but stop it
in the middle to inspect the results
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Checkpoints pauses the script so you can 
inspect results
before continuing

Adding a Checkpoint
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I want to export my results to a spreadsheet
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Supports Multiple
Export Formats

Export Results to Excel
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I have a script that I want to run against
multiple databases
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Use the "Develop SQL and Routines" activity to develop 
SQL scripts to deploy:
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To deploy the scripts to multiple servers, you want to have
server profiles for each of the server that you need to 
deploy your SQL to:
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Some may have been created automatically for you. To create
the missing ones, use the "New Server Profile" Button:
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Use Window->Show View to open Deployment Manager:
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Click on the icon to create a new deployment group
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Once a deployment group is created, you can drag/drop your 
server profiles to the "Server Profiles" folder:
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Use a Data Development Project to hold SQL scripts. You can
create your own in the Data Project Explorer:



24

IBM Information Management

Once scripts are created, you can drag drop these scripts to the
"Artifacts Folder" in your deployment group:
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Results are recorded in SQL Results View

Use Deploy to deploy scripts to servers in Server Profiles
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What’s the difference between my 
Development

And
Test Database
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Scenario
� Changes made out of data studio. 

� Not only one way changes

� Need define migrate rule, like mask schema, ignore some objects

Solution:

© 2013 IBM Corporation27

Test

Production

ER Model

Development

Database  shops have multiple 
database tiers i.e. development, test, 
and production.

Ideal Change Flow

Migrate complex changes
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Migrate a data object as new one

o Approach in Data Studio:  Copy/Paste

� copy the objects homogeneously

� copy database objects heterogeneously

o Note:

� Not intended for copying large databases

� The object limit includes all of the dependent 

and contained objects for the selected objects

� Exclude dependent and contained objects from 

the copy process by using options on the Source/Target page in the Paste 

Database Objects wizard

Migrate and Sync Single Object
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Migrate and Sync a data object to an exist one

o Approach in Data Studio:  Compare With Another Object...

o Steps:

� Open Compare Editor

� Browse and Copy Changes 

� Generate delta DDL and deploy changes to database

Migrate and Sync Single Object
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Sync GSDB and GSDBTEST

o Painpoints in migration plan:  

� Identify Changes together
� Impact analyze for all modified objects together
� Run DB commands together
� Rollback changes if error occur

o Steps:

1.Identify source type and 
select corresponding  
database to migrate 

Compare and Migrate Objects
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2. Filter objects

Compare and Migrate Objects
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GSDB – "Production Database" GSDBTEST – "Test Database"

Identical tables

Different schema 
names

False Positives
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Ignore the difference

Filter Out False Database Objects - Ignores
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Filter out those false positive

Notice objects 
filtered out
Notice objects 
filtered out

Before

After

Filter Out False Database Objects - Ignores
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3. Mask and Ignore database objects

Compare and Migrate Objects
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3.  Identify difference between source and target 
source and target ,copy the relative change want to  apply

Identify the difference

Compare and Migrate Objects
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5.  Click Preview Commands to generate change DDL  

Can also generate Undo 
to roll back change

Application DBA can 
send to Operation DBA, 
and schedule the time to 
run

Compare and Migrate Objects
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I want to make changes to my database
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� Improve DBA efficiency
• Multiple changes in one plan
• Saves and restores data for extended alters, 

ensure data integrity
• Automatically manages dependent objects, 

mitigates risk related objects changes.
• Analyzes and reorders changes if necessary.
• Generates needed maintenance commands
• Schedule changes with Data Studio Web 

Console.

Object Management
Improve DBA productivity and reduce application 
outages by automating and simplifying complex DB2 
structural changes.  

Multiple changes

Identify the 
changed objects
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� Reduce errors and downtime
• Provides impact analysis visualization 
• Factors in impacts and side effects automatically 
• Automatically generates commands to rollback changes

DDL with 
maintenance 
commands

Undo Commands 
to Rollback 
change

Object Management
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� Foster teamwork and enhance audit ability
• Integrate into InfoSphere Data Architect
• Integrate with High Performance Unload for large data set
• Documents changes for collaboration and audit

Deployed scripts, 
Report, undo scripts

Object Management

View all history 
change plans
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5. View 
relationships 
using Overview 
Diagram

3.  Diagram of 
relationship

4. List of 
relationship

2. Select Analyze 
Impact… on 
database object

1.  Select object 
in Object List

Impact Analysis
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What about Running Utilities
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1. Click the Back Up menu

Backup a database
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2.Specify options

Back up a database
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3.Review command and execute, can also go to Edit i n SQL Editor and schedule in Web Console

Backup a database
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Looking at Data
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Browsing Data
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Filter data result
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Highlight  the changed row.

Click         icon or Save ,Ctrl+S to commit the change

Edit Data
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Coming improvements
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� A lot of users use only Data Studio to run queries against DB2. They feel 
uncomfortable with the complexities of Data Studio. 
�We designed a new UI by removing features that are not used by these 

users, making Data Studio simpler for them to use. 
�We also extended this simplification to Data Studio itself by removing 

some of the Eclipse features that Data Studio users will not use from the 
user interface. 

New Simplified UI
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Complex toolbar and menus
from Eclipse

Complex toolbar and menus
from Eclipse

Data Studio 3.2
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New toolbar and menus
In V4.1

Data Studio 4.1
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� Allows a DBA to set up Data Studio and include the preference settings as 
part of a customized install image. Users who install with the customized 
install image will pick up the preferences that the DBA had set up, 
including connection information, query tuning settings, Data Studio 
Preferences, etc.

Enterprise Deployment Support
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� Overview

� Access Plan Graph and Access Plan Explorer

� Workload Statistics Advisor 

Optim Query Workload Tuner Agenda
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� Single query tuning features sometimes makes sense
– View access plans and sort operators in the plan explorer to focus on problem areas of the statement

– Run statistics advisor to determine if any missing statistics make sense

OQWT Single Query Tuning
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� Visualize access path

• See flow of query processing

• See indexes and operations

• See optimizer rationale

� Assess access path stability to reduce risk of performance regression

• Is the optimizer able to apply the filtering early?

• Are there indexes that support an efficient path?

• Are statistics collected?

Operator 
details 
area

Access 
plan graph

Facilitate Analysis: Access Plan Graph
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� View operators with 
associated measures in one 
area

� Order operators based on 
measures to identify hot 
spots

� View operator details 

� View table and index use

� View flow of query operator 
processing

� See optimizer rationale

Operator 
with 
optimizer 
estimates

Operator 
details 
area

Sort by 
measures

Facilitate Analysis: Access Plan Explorer
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� Provides advice on: 
• Missing statistics

• Conflicting statistics

• Out-of-date statistics

• Base tables and 
materialized query tables 
(MQTs)

� Simplifies use
• Provides Runstats

statements 

• Run immediately or save

View details including 
distribution, column group and 
index statistics recommendations

Summary for each object
used in the workload

View and run RUNSTATS 
recommendations

Improve Statistics Quality using the Statistics Advisor
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Thank You
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� Comprehensive data management tool 
– An integrated environment for managing databases and developing 

database applications

� Manage database objects based on change plan: Create, Alter, 
Drop

� Database Commands/Utilities Task Assistant

� Data Management

� Develop and execute SQL scripts

� Impact analysis

� Compare database objects

� Develop, debug, and deploy database applications and database 
routines

What is IBM Data Studio?
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� Replaces Control Center from DB2 10

� Built on the popular Eclipse framework

� Support for Red Hat Linux, SUSE Linux, Windows

� Optional extra component

– Data Studio Web console: health and availability monitoring

� No Charge to download and use!

� Support through PMRs and DeveloperWorks forum

What is IBM Data Studio? (cont)
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Switching between Admin and Development
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Flatter View

Hierarchy View

Flatter view and Hierarchy view
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� Flatter view: Click on a type of objects in Administration Explorer to list 
the objects in Object List on the right side.
– Object List contains several features to facilitate navigation such as: 

in-place searching, sorting, etc.

� Hierarchy View: Navigation in Data Source Explorer  will see an object 
hierarchy, Schema->Table->Index

� User can also use the breadcrumb navigated like web browser

� Show related objects: User can also right click an object , Show-> Show 
Indexes etc to navigated to relative objects

� Object Filter: Two way filter
– Database Catalog filter is  filter the object load from data server

– Name search in object list is only for search on UI

© 2013 IBM Corporation6

Multiple navigation
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� Filter load objects

� Filter in current loaded objects

Object Filter
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� Multi-purpose navigation bar

– Web-browser-like back / forward navigation

– Breadcrumb navigation facilitates moving through hierarchy of objects

– Create new object button

– In-place search function. Type object name or part of it and list is dynamically updated.

– Support use of wildcards

– Options to sort, filter, refresh objects list

© 2013 IBM Corporation8

Back/Forward Current Path

New Object

Search Options

Switch to other object

Navigation in breadcrumb
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Navigate by related objects
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I Just want to run a SQL
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1. Launch SQL
Editor

2. Type SQL

3. Run SQL

4. Inspect Results

Launching the SQL Editor



12

IBM Information Management

So I want to run a script but stop it
in the middle to inspect the results
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Checkpoints pauses the script so you can 
inspect results
before continuing

Adding a Checkpoint
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I want to export my results to a spreadsheet
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Supports Multiple
Export Formats

Export Results to Excel
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I have a script that I want to run against
multiple databases
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Use the "Develop SQL and Routines" activity to develop 
SQL scripts to deploy:
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To deploy the scripts to multiple servers, you want to have
server profiles for each of the server that you need to 
deploy your SQL to:
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Some may have been created automatically for you. To create
the missing ones, use the "New Server Profile" Button:
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Use Window->Show View to open Deployment Manager:
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Click on the icon to create a new deployment group
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Once a deployment group is created, you can drag/drop your 
server profiles to the "Server Profiles" folder:
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Use a Data Development Project to hold SQL scripts. You can
create your own in the Data Project Explorer:
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Once scripts are created, you can drag drop these scripts to the
"Artifacts Folder" in your deployment group:
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Results are recorded in SQL Results View

Use Deploy to deploy scripts to servers in Server Profiles
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What’s the difference between my 
Development

And
Test Database
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Test

Production

ER Model

Development

Database  shops have multiple 
database tiers i.e. development, test, 
and production.

Ideal Change Flow

Migrate complex changes
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Migrate a data object as new one

o Approach in Data Studio:  Copy/Paste

� copy the objects homogeneously

� copy database objects heterogeneously

o Note:

� Not intended for copying large databases

� The object limit includes all of the dependent 

and contained objects for the selected objects

� Exclude dependent and contained objects from 

the copy process by using options on the Source/Target page in the Paste 

Database Objects wizard

Migrate and Sync Single Object
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Migrate and Sync a data object to an exist one

o Approach in Data Studio:  Compare With Another Object...

o Steps:

� Open Compare Editor

� Browse and Copy Changes 

� Generate delta DDL and deploy changes to database

Migrate and Sync Single Object
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Sync GSDB and GSDBTEST

o Painpoints in migration plan:  

� Identify Changes together
� Impact analyze for all modified objects together
� Run DB commands together
� Rollback changes if error occur

o Steps:

1.Identify source type and 
select corresponding  
database to migrate 

Compare and Migrate Objects
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2. Filter objects

Compare and Migrate Objects



32

IBM Information Management

GSDB – "Production Database" GSDBTEST – "Test Database"

Identical tables

Different schema 
names

False Positives
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Ignore the difference

Filter Out False Database Objects - Ignores
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Filter out those false positive

Notice objects 
filtered out
Notice objects 
filtered out

Before

After

Filter Out False Database Objects - Ignores
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3. Mask and Ignore database objects

Compare and Migrate Objects
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3.  Identify difference between source and target 
source and target ,copy the relative change want to  apply

Identify the difference

Compare and Migrate Objects
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5.  Click Preview Commands to generate change DDL  

Can also generate Undo 
to roll back change

Application DBA can 
send to Operation DBA, 
and schedule the time to 
run

Compare and Migrate Objects
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I want to make changes to my database
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� Improve DBA efficiency
• Multiple changes in one plan
• Saves and restores data for extended alters, 

ensure data integrity
• Automatically manages dependent objects, 

mitigates risk related objects changes.
• Analyzes and reorders changes if necessary.
• Generates needed maintenance commands
• Schedule changes with Data Studio Web 

Console.

Object Management
Improve DBA productivity and reduce application 
outages by automating and simplifying complex DB2 
structural changes.  

Multiple changes

Identify the 
changed objects
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� Reduce errors and downtime
• Provides impact analysis visualization 
• Factors in impacts and side effects automatically 
• Automatically generates commands to rollback changes

DDL with 
maintenance 
commands

Undo Commands 
to Rollback 
change

Object Management
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� Foster teamwork and enhance audit ability
• Integrate into InfoSphere Data Architect
• Integrate with High Performance Unload for large data set
• Documents changes for collaboration and audit

Deployed scripts, 
Report, undo scripts

Object Management

View all history 
change plans
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5. View 
relationships 
using Overview 
Diagram

3.  Diagram of 
relationship

4. List of 
relationship

2. Select Analyze 
Impact… on 
database object

1.  Select object 
in Object List

Impact Analysis



43

IBM Information Management

What about Running Utilities
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1. Click the Back Up menu

Backup a database



45

IBM Information Management

© 2013 IBM Corporation45

2.Specify options

Back up a database
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3.Review command and execute, can also go to Edit i n SQL Editor and schedule in Web Console

Backup a database
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Looking at Data
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Browsing Data
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Filter data result
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Highlight  the changed row.

Click         icon or Save ,Ctrl+S to commit the change

Edit Data
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Coming improvements
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� A lot of users use only Data Studio to run queries against DB2. They feel 
uncomfortable with the complexities of Data Studio. 
�We designed a new UI by removing features that are not used by these 

users, making Data Studio simpler for them to use. 
�We also extended this simplification to Data Studio itself by removing 

some of the Eclipse features that Data Studio users will not use from the 
user interface. 

New Simplified UI
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Complex toolbar and menus
from Eclipse

Complex toolbar and menus
from Eclipse

Data Studio 3.2
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New toolbar and menus
In V4.1

Data Studio 4.1
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� Allows a DBA to set up Data Studio and include the preference settings as 
part of a customized install image. Users who install with the customized 
install image will pick up the preferences that the DBA had set up, 
including connection information, query tuning settings, Data Studio 
Preferences, etc.

Enterprise Deployment Support
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� Overview

� Access Plan Graph and Access Plan Explorer

� Workload Statistics Advisor 

Optim Query Workload Tuner Agenda
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� Single query tuning features sometimes makes sense
– View access plans and sort operators in the plan explorer to focus on problem areas of the statement

– Run statistics advisor to determine if any missing statistics make sense

OQWT Single Query Tuning
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� Visualize access path

• See flow of query processing

• See indexes and operations

• See optimizer rationale

� Assess access path stability to reduce risk of performance regression

• Is the optimizer able to apply the filtering early?

• Are there indexes that support an efficient path?

• Are statistics collected?

Operator 
details 
area

Access 
plan graph

Facilitate Analysis: Access Plan Graph
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� View operators with 
associated measures in one 
area

� Order operators based on 
measures to identify hot 
spots

� View operator details 

� View table and index use

� View flow of query operator 
processing

� See optimizer rationale

Operator 
with 
optimizer 
estimates

Operator 
details 
area

Sort by 
measures

Facilitate Analysis: Access Plan Explorer
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� Provides advice on: 
• Missing statistics

• Conflicting statistics

• Out-of-date statistics

• Base tables and 
materialized query tables 
(MQTs)

� Simplifies use
• Provides Runstats

statements 

• Run immediately or save

View details including 
distribution, column group and 
index statistics recommendations

Summary for each object
used in the workload

View and run RUNSTATS 
recommendations

Improve Statistics Quality using the Statistics Advisor
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Thank You


